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Introduction

1.1 Description

‘RATS’ stands for Regression Analysis of Time-Series. Although, as the title
suggests, the program was initially developed for the estimation of time-
series econometric models, recent versions of the software have a wide
range of features which would be of use in the analysis of cross-sectional
or panel data.

RATS is an econometric modelling package that enables the researcher
to transform, analyse and estimate models for actual data, and also to
conduct simulations using artificial data created in almost any way he
chooses. The advantage of RATS over more traditional programming lan-
guages is that you do not have to ‘re-invent the wheel’ since most of the
tasks that are of interest will be available by issuing just a couple of
commands. Thus, RATS provides a useful bridge between simple but in-
flexible packages which are entirely menu driven, and full programming
languages (such as FORTRAN or C/C++), which would require you to code
up even OLS regressions yourself. The advantage of instruction-based pro-
grams such as this is that they make it quick and easy to replicate a set of
results or to repeat the same analysis using a large number of different
series; both would be more troublesome and time-consuming with pure
menu-driven packages.

Recent versions of RATS have made the software even more powerful
and yet simpler for novices to get to grips with via the use of ‘Wizards’,
which will be described in detail below. Over the past 12 years, I have
used RATS for much of my empirical research, and have co-authored two
software reviews that feature RATS and focus on the estimation of models
for volatility -- Brooks et al. (2001, 2003).1

1 See Chapter 8 of this handbook for a discussion of how to estimate such models.
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2 RATS Handbook to Accompany Introductory Econometrics for Finance

While this book has made use of version 7 of RATS throughout, most
of the procedures are also available in older versions of the software. The
discussion below assumes that the reader has obtained a licensed version
of the package and has loaded it onto a computer. While there are broadly
four platforms for RATS (Windows, Mac, UNIX and a command prompt
from a PC), this guide assumes throughout that WinRATS, the Windows
version, is used. In all three cases, the researcher is required to write a
set of instructions and to run them. The interfaces are also similar.

1.2 RATSDATA

RATSDATA is a simple-to-use, menu-based program for handling data. It
can be used to import data into files which have a special RATS format
with a ‘.RAT’ suffix, and also to export data from RATS to another for-
mat or to print or plot variables in the dataset. A principal advantage
that previously existed in converting data files to RATS format was the
increase in speed of reading and writing the data; now that computers
are faster, this hardly matters and many of the features of RATSDATA are
incorporated into RATS itself. Hence this book will not use RATSDATA or
discuss it further.

1.3 Accomplishing simple tasks in RATS

There are essentially two ways to run programs in RATS: interactively or
in batch mode. To use interactive mode, you write the instructions in the
RATS Editor and RATS will execute each line after you have typed it and
hit <ENTER>. Using batch mode involves writing all of the commands
together and then running them in a single go. Any text editor could be
used to write the instructions, including the RATS Editor, and there are
also various ways to run them. These will be discussed in detail below.

1.4 Further reading

Readers who wish to learn more about the functionality of the software
should consult the RATS User Guide, which is a highly detailed but sur-
prisingly readable description of the features and working of RATS, in-
cluding numerous examples and technical details. Enders’ (2003) RATS
Programming Manual is also useful for those already familiar with the soft-
ware and who want to enhance their knowledge of how to write RATS
programs. Finally, the RATS Reference Manual provides an alphabetical list-
ing of all of the instructions and functions available in RATS. All three of
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Introduction 3

these are distributed electronically with the software and hence should
be freely available to all readers.

1.5 Other sources of information and programs

The Estima web site (www.estima.com) provides links to a long list of RATS
procedures, which make the implementation of many complex tasks very
easy. Some of these procedures will be described in subsequent chapters
of this book.

Estima’s site also includes a link to the RATS web-based discussion forum
(www.estima.com/forum), where users can post or respond to questions
about aspects of the software or programs, and there is also an e-mail-
based discussion group, to which users can subscribe and make postings.

1.6 Opening the software

To load RATS from Windows, choose Start, All Programs, WinRATS 7.0 and
again WinRATS 7.0. An empty window called ‘NONAME00.TXT{io}’ will be
opened. {io} denotes ‘input-output’, i.e. this file is both an input file (for
writing instructions and telling RATS what to do) and an output file (for
RATS to write the results in). The screen will appear like the one below.

Screenshot 1.1

However, it is often desirable to have two separate files open on the
screen at the same time -- an input file where the program will be written
and an output file where the results will be displayed. To achieve this,
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4 RATS Handbook to Accompany Introductory Econometrics for Finance

click on the File menu and choose New. A second file will be displayed
on the screen called ‘NONAME01.TXT’. Go into the Window menu and
choose ‘Use for Output’ -- you will notice that the name has changed to
‘NONAME01.TXT{o}’ as shown on the left-hand side of the file tab. This
will be the output file that the results will be placed in. If you look at the
first file, the name has now changed to ‘NONAME01.TXT{i}’ -- this is the
program file where the commands will be written.

It is a good idea to save the files frequently. With RATS, you must save
the input and output files separately (unless of course you do not want
to save the output). The way to do this is to go into the File menu and
choose ‘Save As’. Note that RATS will then be saving in a file the display
window that is on the top, which is the output window. Assuming that
you want to save the input file instead, click Cancel and select the tab of
the input window underneath. Click ‘File’ and ‘Save As’ again and save
the open file ‘NONAME00.PRG{io}’ as XX.prg. Replace ‘XX’ with any file
name you consider appropriate. It is usually best to keep file names to a
maximum of eight characters.

Finally, to have a nice window display so that you can see both the
input and output files at the same time, click on the | I

o button. This is
equivalent to going to the Window menu and choosing ‘Tile Horizontal’
rather than ‘Tile Vertical’. The former will put the input window above
the output window, while the latter will put the input window on the
left and the output window on the right. The screen should now appear
as shown below.

Screenshot 1.2
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Introduction 5

The 12 icons (buttons) that appear near the top of the window by default
have the following functions (which are also available by clicking on the
appropriate menu item):

Open file

Save file

Print the contents of the active window (the window on top)

Function look-up, which opens up the functions wizard

Use this window for input

Use this window for output

Tile windows horizontally (one below another)

Tile windows vertically (side by side)

Edit -- select all

(RUNNING PERSON) Runs the selected instructions, or the
instruction on the cursor line, if any (equivalent to hitting
<ENTER>). Disabled if the active window is not the input
window.

Ready/Local (R/L) -- this is a toggle switch. Clicking on this
icon switches RATS from Ready to Local (L/R) mode and
clicking again would switch RATS back to (R/L). Instructions
are keyed in when RATS is in local mode, and clicking on
the L/R button will then enable the program to be run by
clicking on the RUNNING PERSON. The RUNNING PERSON
button is unavailable when RATS is in local mode. The R/L
button is disabled if the active window is not the input
window.

Clear program -- this clears the memory.

1.7 Types of RATS files

The convention is to name program files (that is, files containing RATS
instructions) with the extension ‘.PRG’ or, less commonly, ‘.RTS’ and the
output files with the extension ‘.OUT’. It is usually best to follow this
convention so that the file type is obvious from the extension. In the RATS
directory, there are also files with the extension ‘.SRC’. These are special
pre-programmed sets of instructions, known as RATS procedures, which can
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6 RATS Handbook to Accompany Introductory Econometrics for Finance

be called from within a program file to do certain tasks (e.g. testing for a
unit root), rather like sub-routines in a programming language. Note that
both input and output files are always saved as raw text (i.e. ASCII format),
whatever they are called.

1.8 Reading (loading) data in RATS

Before performing any formal analysis, the data must be loaded into the
software. Suppose that the data consist of monthly observations on Voda-
fone’s Share Price (Vodafone) and the FTSE All Share Price Index (FTALL)
from November 1984 to February 2007. Suppose also that the data file
is in ASCII (i.e. raw text) format, has two columns of length 268 ob-
servations and is called THEDATA.DAT (initially saved in the WinRATS
Directory).

The CALENDAR instruction will be the one that will read in the data.
In previous versions of RATS, it was necessary to type these instructions
manually in an editor, but now the Data Entry Wizard can be employed
to do the job. The following example will show how to achieve that but
first, various usages of CALENDAR are highlighted. The basic structure is
CALENDAR(frequency) start date e.g.

CALENDAR(M) 1998:4

would be used for monthly data starting in April 1998;

CALENDAR(Q) 1980:1

would be used for quarterly data starting in quarter 1, 1980;

CALENDAR(7) 2002:8:16

would be used for daily data with 7 days per week starting on 16 August
2002;

CALENDAR(A) 1985:1

would be used for annual data starting in 1985. With annual data, the
number after the colon must always be 1.

Note that this command, like most others in RATS, can be abbreviated
to its first three letters, CAL, or the whole command can be used.
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Introduction 7

The ALLOCATE command works with CALENDAR and tells RATS when
the sample period finishes. For example,

ALLOCATE 1999:10

would be used for data finishing in October 1999;

ALLOCATE 2007:10:30

would be used for data finishing on 30 October 2007.
Note that it is also possible to use numbers rather than dates with

the ALLOCATE command. For example, if the series in the data file each
contained 180 observations, it would be possible to use

ALLOCATE 180

Now that the arrays to store the data have been established with the
CALENDAR and ALLOCATE instructions, the OPEN command can be used
to open a new or existing file. For example

OPEN DATA C:\WINRATS\THEDATA.DAT
DATA(FORMAT=FREE,ORG=OBS) / VODAFONE FTALL

In this case, RATS opens the data file THEDATA.DAT that has been saved
in the WINRATS directory on the C drive. Note that if the data file is saved
elsewhere, you would have to specify the correct path, e.g. for data on a
pen drive attached to a USB port that was named E:\

OPEN DATA E:\THEDATA.DAT

DATA reads data series from an external file into the working memory.
The general ‘syntax’ (form of the command) is

DATA(options) start end list of series

where ‘ start end’ is the range of entries to read and ‘ list of series’ is the list
of series names for RATS to read from the file. The following options are
available on how the data are arranged in the file:

ORG=[VAR]/OBS: this tells whether the data are blocked horizontally by
series -- i.e. in rows (ORG=VAR) -- or by observations -- i.e. in columns
(ORG=OBS). Note that the term appearing in square brackets is
always the default.
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8 RATS Handbook to Accompany Introductory Econometrics for Finance

Organised by Observation implies that the series appear in separate
columns:

X1 X2
100.0 405.0
105.3 905.2
103.9 630.1
206.7 890.2
200.1 332.2

Organised by Variable implies that the series occur one at a time in
blocks:

X1 100.0 105.3 103.9 206.7 200.1
X2 405.0 905.2 630.1 890.2 332.2

FORMAT=[FREE]/PRN/WKS/DBF/RATS/XLS ‘(FORTRAN Format)’
This tells RATS which format to use for your data set. For instance, if

your data are in an ASCII (text) file, then you would use FREE and if
your data are in a Lotus worksheet, use WKS, Microsoft Excel (XLS),
etc. For text-based files, RATS assumes that there are no series labels
(e.g. X1 or X2), so that the data file contains only data and no strings
of row or column headers.

Putting this all together, the four lines of code below will load the data
and assign the name VODAFONE to the first column of observations and
FTALL to the second for monthly data starting in November 1984 and
finishing in February 2007.

CALENDAR(M) 1984:11
ALLOCATE 2007:02
OPEN DATA C:\WINRATS\THEDATA.DAT
DATA(FORMAT=FREE,ORG=OBS) / VODAFONE FTALL

1.9 Reading in data on UK house prices

Open RATS version 7 and click File, New. Then click on the ‘I’ icon ( ) to
use this as the input window, so that the other window will become that
to receive the output. Next, tile the windows horizontally by clicking the
‘I|O’ icon. It is probably easier to be able to write several lines of code and
then to run them in a batch rather than allowing RATS to run each line
after we hit <ENTER>. Your screen should probably look like the one in
Screenshot 1.3.
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Introduction 9

Screenshot 1.3

Note in particular that the ‘R/L’ button has R first and the running man
icon is in darkened blue typeface on the screen. This means that RATS is
in ‘ready’ or ‘run’ mode and will run instructions line by line. To switch
this off, click the ‘R/L’ button. This will switch RATS to ‘local’ mode, where
R/L will become L/R and the running man will be in grey, denoting that
this button is now not operational. The top left part of the screen will
now appear as

Screenshot 1.4

RATS is now in a position to be able to write a set of instructions
together and then they will be run in a batch.

The first task is to read in (import) a series of UK average house prices
from a Microsoft Excel spreadsheet called ‘UKHPR.XLS’. There are 197
monthly observations running from January 1991 to May 2007. From in-
side RATS, click on Data and then Data (Other Formats). You will then be
asked to find the directory that the file has been placed in and the name
of the file. Make sure you change the file type from ‘Text Files (∗.∗)’ to
‘Excel Files(*.XLS)’. Once you have done this, click Open and the ‘Import
Format’ Screenshot 1.5 will be observed.
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10 RATS Handbook to Accompany Introductory Econometrics for Finance

Screenshot 1.5

RATS has peeked inside the file and determined how the data are or-
ganised. Usually, it will do this correctly, but just to check: the data are
indeed organised in columns and there are two columns of data to pro-
cess (including the dates column). There are no header lines before the
series labels and no footer lines, so click OK. Then the ‘New Series Date’
window will appear.

Screenshot 1.6

RATS has again peeked inside the file and correctly identified that
we have monthly time-series data, so verify again that the window is
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